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Milestones Professional 2017 New/Improved Features 
 
Improved Undo 
 
A new Multiple Undo feature has been added to Milestones. Now all actions can be undone. You can set the number of 
actions that can be undone from 1 to 100 (the default is 20). This is done using the Tools | Program Options | Edit 
screen: 
 

 
 
Each time anything changes in the schedule, a complete copy of 
the schedule is saved to memory before the action is applied. To 
see all the pending Undos you can press the Edit | Undo List 
button: 
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Improved Toolbar Icons and High Resolution Support 
Milestones now automatically adjusts to operating on a high resolution monitor, sometimes referred to as a “4K” 
monitor. In the Apple world, these are referred to as “Retina” displays. 
These high resolution monitors come in such resolutions as 3200x1600, 3840x2160 etc. 
 
 
 
More Column Indicator Conditions 
The number of indicator conditions has been doubled, from 10 to 20: 
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Show ValueSet Values inside DataGraphs 
For line and normal bar (non-stacked) graphs you can show the value of the bar near the top of the bar:

 
 

This is done using new check boxes in the ValueSet Properties dialog: 
There are separate settings for both bar and line graphs in case you 
are overlaying a line graph on top of a bar graph and do not want 
numbers for both. 
 
The number for a bar is centered over the bar. The number for a line 
graph is centered over the end date of the value period. 
 
The software cannot make room for numbers that do not fit, so if the 
bars are not wide enough then it may be that the values will overlay 
each other. 
 
If you have negative values, the value will be shown below the bar or 
line: 

 
 
Or, if you have a line or point graph, you can force all the values to be below the line. This is useful if you have multiple 
ValueSets on the same DataGraph. 
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New Symbol Date Format 
The Time of a symbol may now be appended to the displayed symbol date. Before, it was not possible to display both 
date and time in the symbol date display area: 
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Global Symbol Values 
A new tab was added to the Toolbox Symbol Options dialog that lets you specify default values for any of the nine 
possible ValueSets. Any new symbols created will have their attached ValueSet values set to these defaults: 
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Free Form Text Hyperlinks 
Free Form Text may now have a hyperlink attached. There is also a checkbox that enables you to specify that any time 
the text is clicked upon, the hyperlink is launched. Without this checkbox active, you must right-click on the text to 
launch the hyperlink. 

 
When a PDF is created with such a block, the entire text block becomes a hot spot, but there is no button drawn as there 
is with other hyperlinks, since the button would obscure the text.  
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Date Headings Attached to Rows independent of Schedule Date Headings 
It is now possible to attach any single type of date heading to a row. Now, when you right-click on the menu to attach a 
date heading to a row, a dialog appears that lets you remove the heading, attach a copy of the schedule headings, or a 
single independent heading of any type: 

 
 
 
Independent headings are always the height of the row. It is up to you to ensure the font size is appropriate. If you want 
headings and sub headings, then you would attach different headings to subsequent rows. 
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Autosave Improvements 
When a Milestones session exits it now only clear autosaves done by its own Process ID (PID), not any others whether 
they are running or not. This should prevent an autosave entry from disappearing without the user being able to restore 
it. This fixes the problem of multiple Milestones sessions running and deleting autosaved files from a crashed session 
before the user gets a chance at a restore. 
The autosave Restore dialog now prompts the user to select an entry before OK is accepted. Before, if the user forgot to 
select an entry the autosave files were deleted. 
Also added, was a new button in the Tools | Program Options | Files and Automation screen which lets you display the 
current list of Autosaved files: 
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Two Stage File Save Improvements 
Before, when saving a Milestones file using the two stage save option, the original file was zeroed out before the local 
temp file was successfully saved, so if there was a Milestones crash or system crash creating the local temp file, the 
original file remained truncated at 0 length.  
Now, the original file is not zeroed out until the temporary local copy is successfully created. So, if there is a Milestones 
or computer crash during a file save, either the original will be left intact, or the temporary copy. 
The temporary copy is saved in the user’s temp folder and has a .MLG file extent. A menu option was added to the File 
Open menu which lets you open any Milestones files which may be in the temp folder. The option is useful since the 
temp folder is under the hidden AppData folder under the user’s account folder and is difficult to navigate to: 
 

 
 
Although the temporary Milestones file has a system generated name, it be a life saver in the case where there was a 
crash during a file save and this is the only good copy of a file. 
It is also possible that a .MLG file in this folder will be an incomplete copy if there was a crash while the temp file was 
being written. In this case though, the original file should still be intact in the user’s normal Documents folder. 
Normally, where there have been no Milestones or system crashes during a file save, there will be no Milestones files in 
the user’s temp folder. 
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Show Symbol Type in Status Bar when Symbol is Selected 
Now when a symbol is selected, then actual symbol will be shown in the Status Bar: 

 
 
Before, just the fill color was shown. Note that the color shown and the actual symbol type is always the “before status 
date color” and “before status date symbol type”. The status bar does not know if the symbol is before or after the 
status date. Invisible symbols are shown as a single vertical line.  
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Line by Line Color in Free Form Text 
Using the same <RGB: nR, nG, nB> command you can causes an entire line in a Free Form Text block to be a different 
color: 

 
Keep in mind, that if this file is backsaved to any prior version, the RGB commands will be visible in the text and the RGB 
commands will be ignored by the prior version. 
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Clear Symbols Settings Dialog Improved 
The Manage Symbols option in the Tools menu has had a couple of options added: the ability the remove all symbol text 
and the ability to remove all vertical connections: 

 
In the past, this dialog was only displayed if you pressed Alt+Shift+F7. 
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Border Choices Added To Freeform Text 
It is now possible to control the border around Freeform text. Before, the border was only a single width solid black line. 
That remains the default. 
The new settings are in the Freeform Text Selection Toolbar: 

 
The Draw Border checkbox has been moved from the Background group to the new Border group. The border color and 
border line type settings are new with version 2017. 
These same controls have also been added to the Freeform Text Options dialog box: 
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Ability to Shift Selected Symbols Added 
It is now possible to shift selected symbols back or forth using the Dates | Shift All Task Dates option: 
 

 
 
If any symbols are selected when you press the button, the Shift All Dates dialog is customized for shifting selected 
symbols. The options not appropriate for this type of shift are grayed out. The symbols remain selected after the shift is 
done and the screen is refreshed. 
Every selected symbol is shifted. No dependent symbols are shifted. Lock to date constraints or locked baselines are 
ignored. 
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Legend Can Now Automatically Show After Status (incomplete) Version of symbols/bar 
If you check the “Show After Status Settings” in the Legend Entry Edit screen, the legend will show the after status 
(incomplete) version of the symbols/bar. This makes it easier for people who wish to show legend entries for both 
complete and incomplete tasks. They no longer need to manually create an incomplete version of their symbols/bar: 
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Selectively suppress interior column dividers 
The Frame dialog now lets you selectively suppress interior column dividers on the left or right side of the schedule: 
 

 
 
 
Ignore Automatic Top Margin Calculation Checkbox Added to Layout Menu 
This checkbox, which is also in the Tools | Options | Edit screen has been added to the Layout menu: 
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Manage FreeForm Text Blocks 
A dialog box was added which lets you see all the Free Form Text blocks in the schedule. You can delete them, change 
the page, hyperlink or tag using this dialog: 

 
 
 
Select All via Ctrl + A Added for Symbols and Task Rows 
If a symbol or task row is selected and you then press Ctrl+A, all symbols or all rows will be selected. The maximum 
number of symbols or rows that can be simultaneously selected is 450, so if the schedule has more, a warning is 
displayed and the multiple selection attempt is ignored. 
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Automation Changes 
SetFreeTextProperty TextAngle Property Added 
SetFreeTextProperty(ntext, “TextAngle”, nAngle) 
nAngle can be 0 (0 degrees), 1 (90 degrees), or 2 (-90 degrees) . 
 
New Methods for Capturing Toolbox Items 
GetConnectorBitmapEx is used to get a bitmap of a connector. 
For example, on a 100% scale DPI system (96 DPI) GetConnectorBitmapEx(8,0,0) returns this bitmap: 

 
GetVerticalConnectorBitmapEx is used to get a bitmap of a vertical connector 
For example, on a 100% scale DPI system (96 DPI) GetVerticalConnectorBitmapEx(6,0,0) returns this bitmap: 
 

 
GetSymbolBitmapEx is used to get a bitmap of a symbol. 
For example, on a 100% scale DPI system (96 DPI) GetSymbolBitmapEx(8,0,0) returns this bitmap: 
 

 
GetComboBitmapEx is used to get a bitmap of a symbol/connector/symbol from a row in the combo toolbox. 
For example, on a 100% scale DPI system (96 DPI) GetComboBitmapEx(8,0,0) returns this bitmap: 
 

 
Each of these new methods share a common set of arguments: 
Argument 1: the1-based number of the toolbox symbol, row, connector or vertical connector 
Argument 2 (optional): the height in pixels of the resultant bitmap. If not present or zero, then the following bitmap 
sizes are used: 
Symbol: 32x32 pixels 
Vertical Connector: 48x48 pixels 
Toolbox row (symbol/connector/symbol): 129x32 pixels 
Connector: 97x32 pixels 
When argument 2 is present, then the height and width is based on the argument. The width is based on a multiple of 
the height for the bitmaps that include a horizontal connector. 
Argument 3 (optional): Respect current DPI setting. If this argument is 1, then the current DPI setting is used to enlarge 
the resultant bitmap. For example, if the computer is running at a 200% font scale (192 DPI), then the resultant bitmap 
will be doubled in size. So, if your computer is set to 200% DPI and if this argument is 1 and argument 2 is 0, then the 
resultant bitmap size of a symbol bitmap will be 64x64 pixels. If argument 2 is present and not zero, then if argument 3 
is 1, then the bitmap size specified in argument 2 gets multiplied by the current font scale factor. 
Argument 3 is important because it lets the caller decide if DPI awareness is important. For example, if the caller is not 
DPI aware then the caller would most likely not use argument 3, since he would be running in a non-DPI aware sandbox 
where Windows is automatically enlarging his bitmaps. 
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Symbol Tags Report Improved 
The Symbol Tags Report in the Tools Menu, 

 
can now provide a combined report for all open schedule. When the report is run, the report is for the current file: 

 
If the “Include All Open Files in Report” button is pressed, then the report is rerun using all the currently open files in the 
Milestones session: 

 
The list of files appears at the top of the report. A new column is added showing the file number used for each line of 
the report. 
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Automatic Page Breaks 
You can now insert Page Breaks automatically based upon outline level or number of rows: 
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Can Now Customize Toolbox Background Color 

You can now customize the Toolbox current selection background color. The default color remains:  
To change it, just right-click in the Toolbox and select Toolbox Properties: 

 
Note that this is a machine setting. The color is not saved with the file. 
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Toolbar Height Override moved to Separate Dialog 
Now that the defaults for the toolbar height (and width when on left) are getting set correctly it should not be necessary 
to ever override the height or width. However just in case there are still some as yet undiscovered issues I don’t want to 
remove the control entirely. Instead, I have allowed different values to be set for height and width override, but they get 
set in a dialog: 

 
Note that 100%, 150%, etc. are displayed next to the default value for that scale factor. That makes it easy to reset to 
the default for whatever scale Windows DPI factor you are running at. 
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Column Headings now displayed in Custom Import Screen 
Now, when you do a custom import from any column headings are displayed next to the column numbers in the right 
side list box: 

 
 
This should help people make the right column selection in the import mapping. 
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New Note Connector Type 
There is now half-size bubble note connectors: 
 

 
 
 
Note that if the file is back-saved to version 2015 or 2012, the connector is switched to the full size version of the bubble 
connector. 
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Refresh from Clipboard 
In version 2017, two Clipboard Import features have been added. 
First, in the File | Import from Clipboard, a checkbox has been added that enables you to specify a UniqueID field that is 
used to tag all the imported symbols, cells, and columns. 
The picture below has the checkbox, import field and mapped UniqueID setting circled: 
 

 
 
For this option to work, the first row of data placed on the Clipboard must be a row of column headings which are then 
used as the tag names placed in the symbol, columns, and cells. 
Second, once a schedule has been imported and tagged, you can then use the new Connections | Refresh from 
Clipboard option: 
 

 
Before selecting the above menu item, you need to have copied the refresh data to the Clipboard: 
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Note that the data to be refreshed that you copy to the clipboard must include a column that is used as a UniqueID and 
each column heading needs to match the tags in the schedule that you are refreshing. 
When you click the Refresh from Clipboard button, and the data on Clipboard seems valid, then the following screen is 
displayed: 
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You select the UniquedID field, any other options, then Press OK. 
When the Refresh is complete a message box is displayed with the results: 
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Thumbnail Image Now Shown in Startup Choices Dialog 
In version 2017, the startup choices dialog now shows a thumbnail of the currently selected file. 
Note that only thumbnails of existing Milestones files are shown. Temp files such as those opened from an email or MS 
Project files have no thumbnail to show: 
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Features Removed 
 
It is rare to have a feature removed, but with version 2017 it was time to remove some. 

1. OLE Drag and Drop. This feature has had issues for quite some time. It was intended to be a shortcut for doing 
an OLE Copy Schedule operation. Since it is difficult to make it work properly I decided to remove it. The 
Toolbar icon used to initiate this operation has been removed. I doubt many people were using this since it 
was so difficult to make work correctly. The Edit | Copy Schedule (OLE) remains the preferred way for copying 
a Milestones OLE object to another application. 
 

2. OLE In-place activation support. This feature, which has always been off by default, allows a Milestones 
schedule to be operated upon while in-place inside an Office document. Since Office started using a ribbon, 
this feature has been strange to use, since Office reverts to a menu, instead of a ribbon, in order to support 
the shared menu and Toolbox required by in-place activation when it is used, I decided to cease supporting it. 
See below for an example of what an in-place Milestones object looked like inside Word 2013: 

 
The Tools | Options | Files and Automation checkbox used to turn this option on has been removed. Now, when 
you double-click on a Milestones object it will continue to launch Milestones in a separate window for editing 
the embedded object. I doubt many people, if any, were using this option since to use it you also had to turn off 
the sidebar option. 

3. File Open and Save from/to Internet 
This feature used the FTP Internet Protocol for opening and saving files. Since this implementation does not 
allow encryption and transmits the password in plain text it is not safe to use from a data security standpoint. 
Many FTP servers now require an SSL encrypted connection to even connect, something we do not support. FTP 
has dropped out of favor over the years. At one time it was the preferred way to transmit files over the Internet, 
but cloud based services such as DropBox, OneDrive, etc. have mostly replaced it 


